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Introduction 
 

What is Z’Analyze Software?  
 

Welcome to Z’Analyze and thank you for choosing this product! In conjunction with a 
Trewmac RF Impedance Analyzer, this software will enable the following: 
 

• Manual collection of impedance data at a single frequency or over a frequency 
range, with averaging for improved precision and an easy-to-use interface. 

 

• Processing and importing of AE Z’Scan .zsd or Bird BDS2 .csv RF sensor data. 
 

• Saving of impedance data as a .csv data or RF sensor data as set as a .csv or 
a .zsd file set. 

 

• Saving program startup parameters for use in multiple scenarios. Z’Analyze also 
saves items such as match computations, including impedance ranges and 
match transition timing. 

 

• View data sets in various formats including, but not limited to, Smith chart, R/X, Z 
mag/phase, Gamma re/im, Gamma mag/phase, VSWR, V/I/phase, and P 
(Power). 

 

• Additionally, data sets can be enhanced visually through the Zoom function, its 
fit-to-screen function, its ability to tile data sets either horizontally or vertically, 
and much more.  

 

• Review previously collected data sets: when viewed graphically, Z’Analyze 
allows different data sets to be viewed simultaneously by overlaying a new data 
plot with a saved reference plot. 

 

• Export gathered data as a .csv file.  
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Helpful Resources  
 
Z’Analyze comes with a set of useful resources to help you navigate, understand, and 
troubleshoot the software.  
 
 

User Manual  
 
The User Manual explains how to install the software, set up supporting hardware, 
navigate the interface, use the software to run impedance tests, change display/scaling 
functions, import data from Advance Energy’s Z’Ware software, and measure the 
impedance range of a connected matching network. 
 
 

Readme File  
 
The “Z’Analyze Readme” file installs with the software and contains information about 
the current version, quick-install instructions, and contact for technical support.  
 
 

Direct Help/Support   
 
If you require additional support not covered in the accompanying documents, there is 
direct support available. To ask a question, report a problem with Z’Analyze, or notify 
Frontier Technical Services of any improvements that can be made to the 
accompanying manual, please contact technical support at crtech@ftsplasma.com. 
 

  

mailto:crtech@ftsplasma.com
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Setup 
 
For a complete setup, the correct software and hardware must be configured.   
 
 

Installing Z’Analyze Software 
 

System Requirements  
 
In order to run Z’Analyze, your personal computer must meet the following 
requirements: 

 
✓ Windows XP or Newer (PC Only) 
✓ A processor with at least 1 GHz 
✓ Approximately 5 MB of hard disk space 
✓ Color Monitor 
✓ Windows-compatible mouse 
 
 

Download Instructions  
 
To download Z’Analyze, follow the link below and select “Z'Analyze 1.10”. 
 

https://www.ftsplasma.com/software 
 
 

  

https://www.ftsplasma.com/
https://www.ftsplasma.com/
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Windows Installation Procedure  
 

1. Z’Analyze will be saved as a .zip file – proceed to UNZIP this file after it is saved 
to your directory. 

 

2. Double-click on Z’Analyze.exe. An ‘About’ window will open a prompt, “License 
file not found”, which displays a PC fingerprint (see Figure 1).  

 

3. Click on “Copy to clipboard”. 
 

4. Compose an email to crtech@ftsplasma.com and paste in the PC fingerprint that 
was copied in step 3. 

 

5. FTS technical support will reply with the license code in a file named “license.txt”. 
 

6. Save the license.txt file into the same folder as Z’Analyze.exe. 
 

7. Once the license file has been recognized, you will now be able to open 
Z’Analyze and view your level of access and license expiration date by selecting 
the ‘About’ option from the ‘Help’ dropdown menu (see Figure 2). 

 
 

Hardware Installation  
 
In order to carry out operations such as testing a Matching Network with Z’Analyze, an 
RF Impedance Analyzer must first be connected to your PC, while your Matching 
Network must simultaneously be connected to this same RF Impedance Analyzer. 

 
 
 
  

Figure 1 

Figure 2 

mailto:crtech@ftsplasma.com
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Using Z’Analyze with an RF Impedance Analyzer and 
Matching Network: 
 
IMPORTANT: READ EVERY STEP BEFORE BEGINNING INSTALLATION!  
 

1. TE3000 series and later models of Network Analyzers can be connected using 
either a USB to Serial Adapter cable or the custom Network Analyzer to USB 
cable provided with the system. 

 
2. TE1000 must use a USB to Serial Adapter cable.  

 
3. To connect your PC to a Network Analyzer using the Serial Adapter cable, first 

insert your USB to Serial Adapter cord into your computer’s USB port. 
  

USB to Serial Adapter Power Supply USB Network Analyzer 
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4. Insert the end of your Serial Adapter Cable into the RS232 slot located on the 
backside of your Network Analyzer. Securely fasten the connection by first 
inserting the Serial Adapter Cable into the RS232 slot, and then rotating its knobs 
clockwise.  

 
 
 
 
 
 
 
 
 
 

 
5. To connect your PC to the Network Analyzer using the A-to-B USB cable, first 

insert your USB cord into your computer’s USB port. Then insert the other end 
into the slot labeled USB on the back of the Network Analyzer. 

 
6. Note that the driver may not install properly, as Windows often chooses a default 

driver not compatible with the TE300X. The Trewmac driver included with your 
software must be used instead and will require a reinstall of the correct driver file. 

 
7. Plug the Power Supply into the DC IN slot in the back of the RF Impedance 

Analyzer. At this point in the installation process, your PC has been successfully 
connected to your RF Impedance Analyzer. 

 

 

  

TE1000 Network Analyzer Back – 
DB9 RS232 port only 

TE300X Network Analyzer has both 
USB and Serial ports. 
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Understanding the Interface 
 
When you first open Z’Analyze, you will see a blank window and a control panel, with 
only the Run tab available. Click on File and select either New (to begin a new file) or 
Open (to choose an existing file).  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
  

Main Display 
Window 

Control Panel 

Data Display 
Options 

Main Display Functions and Scaling Options 
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Control Panel Functions  
 
Once a file is open, the Control Panel will now have four tabs: Graphs, Traces, 
Screen/Data, & Run. 
 
 

Graphs  
 
The Graphs tab allows the user to select which display types are accessible. The 
options are: 
 

• Data 

• Smith chart 

• R/X 

• Z mag/phase 

• Gamma re/im 

• Gamma mag/phase 

• VSWR 

• V/I/phase 

• P (Power) 
 
Checking the box to the left of each option allows the user to view that particular display 
type (Note: Data and Smith chart cannot be unchecked). Clicking on a display type will 
bring up that display in the main display window.  
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Traces 
 
The Traces tab displays the name of each trace that is present in the current file. To 
select an individual trace, click on its name in the Traces tab. To select multiple traces 
at the same time, hold Shift or Control and click on additional trace names.  
 

• Selected traces can be copied using the Copy button on the far-left button of 
Traces tab.  

 

• Copied traces can then be pasted into different files using the Paste button. 
 

• To Rename a trace, ensure a trace is selected, and click on the ‘ab’ button. This 
will allow you to enter the new name. Select ‘OK’ to accept changes.  

 

• Traces in this tab have a colored label box to the left of each trace. To change 
this label color, select the Label Color button and click on a desired color. This 
can be useful for keeping track of files with large numbers of traces.  

 

• To Remove a trace from the file, select the trace and click on the red dash.  
 

• To Delete all the traces from a file, click on the black ‘X’.  
 

• The Parse Data function is enabled only if the file being viewed has data 
containing voltage, current, or phase information. Selecting one or more traces to 
be parsed will open a configuration window, wherein the threshold type, either 
Power or Voltage, threshold value, and a ‘Stop After’ delay value (Measured in 
seconds) can be input. If the ‘Keep original trace’ option is not checked in this 
configuration window, the original trace selected will be deleted after parsing 
(even if no parsing was done); otherwise, an original trace will not be deleted. 

  

Copy 
selected 
traces 

Paste 
traces 

Rename 
selected 

trace 

Label 
Color 

Delete All 
Traces 

Remove 
selected 
traces 

 
Parse 
data 
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Screen 
 
The Screen tab provides the user with the ability to alter the graph or chart being 
displayed by zooming in or out, fitting the chart to the screen size, or resetting the chart 
to the default scale. With the Smith chart selected, the user may alter the grid type. With 
other graph types selected, the user may zoom or fit the vertical and horizontal axes 
separately (Note: Screen tab is not available when viewing the “Data” format). 
 
 

Run  
 
The Run tab controls the actual test using the Network Analyzer. Clicking the blue ‘Run’ 
arrow begins the test sequence. Once a test is running, clicking the blue arrow with the 
red ‘X’ over it will stop it.  
 
The run settings allow the user to select either a single frequency for the test or to 
sweep across a range of frequencies. With “1 freq” selected, enter the number of 
samples to be taken, the average number of samples per data point, and the frequency 
at which the test is to be performed.  
 
With “Sweep” selected, the user must additionally enter the starting and ending 
frequency and choose either a linear (Lin) or logarithmic (Log) scale. 

  

RUN test 

STOP test 
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Main Window Functions  
 

Edit Settings  
 

Clicking on the Edit Settings button brings up the Settings Panel with the following tabs: 
General, Connection, Graphs, Table, Label, Status, Correction, and Reference.  
 
 

General 
 

The General tab allows the user to select default locations to save and open files.  
 

Additionally, the ‘Settings list’ under ‘Startup settings’ can be configured such that 
specific .zst files will be opened at the startup screen by default.  
 

• Selecting Default will load the default settings file, “zanalyze.zst” while not 
displaying any of the files that have been saved to the selection list (See Figure 3 
below for the ‘Select Settings’ prompt viewed at startup of Z’Analyze’ when 
‘Settings list’ has been selected from the General Tab). 

 

 
 
 
 
 
 
 
 
 
 
 

 Figure 3 
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• Selecting Edit Settings list enables the user to change which .zst files will be 
shown upon startup of Z’Analyze (See Figure 4 below). Click ‘OK’ to confirm a 
new list or ‘Cancel’ to discard any changes made.  
 

o This list will be automatically saved into the file “zanalyze.zsl” in the 
ZAnalyze.exe directory.  

 

 
Figure 4 

 
  

Select 
Settings 

File 

Add File 
into List 

Remove 
Selected 

File 

Clear 
List 

Move 
Selected 

Down 

Move 
Selected 

Up 
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Connection  
 
The Connection tab allows the user to select the Com port, Baud rate, and Timeout 
interval used for the connection between the computer and Network Analyzer:   
 

• To establish a connection, the Com port selected must match the Com port on 
the computer that the Network Analyzer is plugged in to. The pull-down menu 
contains eight COM port names. In addition to these, COM ports higher than 
COM8 can be manually entered by typing in the port number into the Com port 
box, ex. “COM17”. 

 
o Ensure that the listed USB Serial Port in your Device Manager for the 

Network Analyzer is the same as the Com port listed in Z’Analyze (See 
Figure 5). 

 

• The Baud rate is the data transfer rate of the cable used to connect the 
computer and Network Analyzer (9600 is standard).  

 

• Time-out is the length of time the Network Analyzer will attempt to connect to the 
computer (Measured in milliseconds).  

 

• Click on the Check connection button to determine if the Network Analyzer can 
successfully connect to the computer. 

 

• Check the Autosave box to have the .zst file saved to the Z’Analyze program 
folder after every run. 

 

• Check the Create backup box to have the .csv file saved to the Z’Analyze 
program folder after every run. 

  

Figure 5 
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Graphs  
 
The Graphs tab allows the user to change the appearance of the selected chart by 
altering the width of the trace lines, the size of the data points, the size and type of font, 
and the color scheme. For graphs other than the Smith chart, the user may also change 
the intervals of the vertical and horizontal gridlines. To customize the color scheme, 
double-click on the item to be changed (i.e., Trace 1 or Dimmed 1) and make your 
selection from the color palette. 

 
 

Table  
 
The Table tab allows the user to select the font size, font type, and number of digits 
displayed in the table section of the chart or graph (Note: Digits is total number of digits 
displayed, NOT digits after the decimal point). 

 
 

Label  
 
The Label tab allows the user to select the font, font size and marker size of labels that 
are placed on the Smith chart. It also allows the user to select the number of digits 
displayed for label values, as well as choose the VSWR values for VSWR circles that 
are added to labels. 
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Status 
 
The Status tab allows the user to choose which set of values are displayed in the 
bottom left corner of the Z’Analyze window. By default, scrolling over any part of the 
Smith chart displays the R/X value at that point. The R/X can be changed to Z 
magnitude and phase, gamma real and imaginary, gamma magnitude and phase, 
VSWR, voltage / current and phase, or power. The number of digits to display can also 
be selected by the user. 

 
 

Correction  
 
The Correction tab provides the user the ability to calibrate out discrepancies due to the 
cable or connection attached to the Network Analyzer’s output. For example, alligator 
clips may be used to attach to a network that is not compatible with the Network 
Analyzer’s output cable. However, they introduce an error into the measurements that 
should be calibrated out using the Correction function, in order to obtain the most 
accurate readings: 
 

1. Create a new Z’Analyze file.  
 

2. Attach the connection device to be calibrated to the Network Analyzer’s output. 
 

3. Under the Run tab of the Control Panel, select either “Sweep” or “1 freq” based 
on the operating conditions you will be using the connection for, and enter the 
required values. You will now run the three-part SOL correction of the test fixture. 
Ensure that the ground connector doesn’t touch anything metal during the 
correction or later during measurements.  
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4. Test the short connection by connecting the alligator clips. Click ‘Run’, and when 
the test completes, rename the trace “Short”.  

 
5. Next, test the open connection by leaving the alligator clips disconnected. Click 

run, and when the test completes, rename the trace “Open”. 
 

6. Attach a 50 ohm load to the connection. Click run, and when the test completes, 
rename the trace “50”.  

 
 
  

Alligator clips connected to form 
a ‘Short’. 

Ends of the Alligator clips do not 
touch for the ‘Open’. 

Alligator clips connected to a 50 
ohm load. 
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7. Determine an appropriate name for the file, ex. ’13 MHz clip correction’, and save 
the file in the folder containing Z’Analyze program files. It should now be 
available to use as the correction file.  
 

8. Under the Correction tab, click Browse and select the newly created correction 
file. Hit Reload file and ensure that the trace names entered under Traces 
section are “Short” and “Open”.  

 
a. The trace names are case sensitive and must be referenced the same 

exact way in both the Traces and the Correction, otherwise the correction 
will not be available.  

 
9. Once the correction file is loaded, clicking the “Apply correction” box under the 

Run tab will automatically adjust for the error introduced from the connection type 
(i.e., alligator clips). Any or all of the three corrections that were previously 
performed may be applied to the Smith chart, by selecting the box for that 
specific instance (Short, Open, and Z = 50). If there is any syntax error in 
entering the name, the following problem with the correction will be seen:  

  
All labeling done 
correctly, check the 
boxes to select 
which corrections to 
apply. 
 

‘Open’ was entered 
incorrectly in the Trace 
name as “open” and is 
therefore grayed out 
and not available. 
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The figure to the left illustrates the difference using a correction file can make in the 
accuracy of your readings. In the first figure, a matching network was tested using 
alligator clips attached to the Network Analyzer test cable. The red trace is the trace 
obtained after the correction had been applied. The blue trace was obtained without 
using the correction option. Note that in this instance, only the Short and Open 
corrections were applied. Because the trace never approaches a 50 ohm purely 
resistive load, the Z = 50 correction is not required, and in fact introduces an error into 
the data if applied.   
 
 
 

 
 
 
 

The second figure illustrates the error caused by using the Z = 50 correction when it is 
not applicable. The trace is shifted outside the boundaries of the Smith chart. This 
implies a negative resistance, which is an impossibility and means the data are invalid.  
 
 
 
 
 
 

  

Corrected red trace using “Short” and 
“Open” options. 

Applying the Z = 50 correction when not 
applicable. 
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Reference 
 

The Reference tab allows the user to load traces from other .csv files that will overlay 
previously opened files for the purpose of expediently comparing data.  
 

• Choose which data to overlay by clicking Browse to search for a .csv file to load. 
Then, from that file, highlight the desired reference trace to be viewed on the 
Smith chart and click Apply. 

 

• Reload file will refresh the data being viewed and update any graphs with the 
chosen reference trace (Note: The selected reference file will be loaded 
automatically when Z’Analyze starts). 

 

• The reference trace line’s width or line thickness and its color can be edited in 
the Graphs tab (See Figure 6). 

 

• From the main display window, clicking the “Show Reference” icon will toggle the 
selected reference trace on or off and either show or hide the data on the Smith 
chart accordingly:  

 
 

 
 
 
 
 
 
 
 
 
 
  

Figure 6 
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Tools 
 
Clicking on the Tools button in the main display window brings up the Tool Panel with 
the following tabs: Match, LC, Cable, Replay, and More.  
 

Match 
 

The Match tab provides the user the ability to determine certain important points of the 
matching network’s range. Clicking the “Find” button enables an algorithm that works to 
find and display the values of the R-minimum, R-maximum, X-minimum, X-maximum, 
and center of the matching network’s range, and label these points on the Smith chart. 
The algorithm is not perfect, and therefore, some manual adjustment may be needed 
using the Add Match Point feature.  
 
Cursor: The cursor function can be used to correct or adjust the values of the 
impedance corners of the Smith chart. To do this, select Show Table and Sample 
Number from the top row of display controls. Now, moving the slide bar located between 
the Smith chart and table will move the cursor along the path of the trace, displaying the 
R and X values in the table below. When the cursor is in the desired position, select the 
point number (N) to be adjusted and hit the “Cursor->” button. The new value of that 
point will be the values listed in the table at that cursor location. Hit “Accept changes” to 
save the new data. 
 
Add Match Point: Another way to designate the values of the impedance corners is by 
selecting a point directly on the Smith chart. With the Match tab open and the desired 
corner position selected, (position 1 – 4) right-click at the new location on the Smith 
chart and select “Add match point.” The impedance of that point is now loaded into the 
table. Make sure that all the match points are selected in the order of measurement, or 
else the timing transitions calculated later will not work or will give nonsensical data. 
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Transition Tab: The Transition tab of the Match section allows the user to determine 
the time that elapsed between points listed in the table. Before finding the transition 
times, ensure the points in the table are in the correct order. To see the sequential path 
of the data points taken, use the color gradient mode (See Display and Scaling 
Functions). Select the Transition tab and click ‘Find’. The seconds between each corner 
point should now be listed in the table. Selecting the “Show Trajectories” box displays a 
line along the path that was used to measure the time between points. Note that the 
Gamma tolerance is the distance from the corner point that the timing actually 
measures. An appropriate gamma value for most applications is about 0.03. If the 
gamma tolerance is too small, the application may not find an appropriate point to use 
and no value will be measured for that path. If the gamma tolerance is too large, the 
measured point will be far away from the actual corner point and result in a faulty timing 
metric.  
 
 

  
Proper Gamma value: Correct time 

measurements 
Gamma too large: Faulty time 

measurements 

 

  

Gamma Tolerance of 0.03: The solid 
green line is the trajectory of the timing. 

Gamma Tolerance of 0.5: The trajectory 
includes only a small portion of the 
distance that was actually covered for 
two of the paths (Gamma too large). 
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LC  
 
The LC tab is used to determine the series inductance and capacitance equivalent of a 
cable or circuit. This can be useful in troubleshooting plasma chambers, by allowing the 
user to isolate the chamber itself or the input into the chamber and determine where the 
reactance is out of tolerance.  
 
To calculate the series inductance and capacitance equivalent values requires a data 
trace with at least two different frequencies. Under the Run tab of the Control Panel 
select “Sweep” and enter the desired values and click “Run”. View the Smith chart with 
both “Show Table” and “Sample Number” selected. Adjust the slider bar to the first 
desired frequency and click the left “Cursor ->” button. Now move the slider bar to the 
next desired frequency and click the right “Cursor ->” button. The equivalent inductance 
and capacitance will be calculated and displayed at the bottom as L (nH) and C (pF). 

 
 

Cable 
 

1. To calculate the length of a cable, first select the cable type from the drop-down 
menu. Z’Analyze will automatically enter the propagation velocity (Vp) of the 
selected cable type (Measured as a percentage of the speed of light). If the cable 
type is not listed, but the cable’s propagation velocity is known, enter it into the 
Vp field manually.  

 
2. Next attach the cable to the Network Analyzer’s test cable (Using the appropriate 

adapter, if required).  
 

3. From the Control Panel, select the Run tab and the “Sweep” option. Enter the 
required information, using a frequency range and number of samples based on 
the Recommended min. frequency step shown above (The frequency step is the 
total frequency range divided by the number of samples).  
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4. Click Run to provide cable data that should trace around the outer edge of the 
Smith chart and look similar to the figure to the left.  

 

To ensure the most accurate measurement, the trace data should at a minimum extend 
past the origin of the imaginary plane on the Smith chart. 
 

Clicking “Calculate” in the Cable Table will now provide the length of the cable (L) in the 
units selected, as well as the propagation time (t) for that particular cable (Measured in 
nanoseconds).  
 
 

Replay 
 

The Replay function in the Tools tab allows the user to capture critical data points by 
viewing data as they were in the process of being recorded, from the starting data point 
to the end data point, in various graphical representations. Only one trace can be 
replayed at any given time. 
 

Data can be played back in two modes: manual replay and automatic replay.  
 

To view data in automatic replay mode, first click Reset; only the first data point will be 
visible once this is selected. Clicking Reset will then enable the Run option. Once the 
Run arrow has been selected and the data playback is being viewed, Stop can be used 
at any point to pause the playback. 
 

To view data in manual replay mode, simply click Reset, then manually click either end 
of the scroll bar; using the Left / Right keyboard arrows will also serve this same 
function by moving the progress bar either left or right by one data point.  
 

Select replay speed by the trackbar: “1” corresponds to the actual speed the data were 
logged at. If time information is not available in the data, then “1” will correspond to 16 
data points per second (See Figure 7). 
 
Note: This function is available only if “replay” was a part of your purchased access package.   

Reset 
 

Run 
 

Stop 

Figure 7 
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More 
 
The More tab contains various options for measuring impedance: “Inverse X”, “Find 
resonant frequency”, “Subtract Impedance”, and “Rotate Gamma”: 
 

• Clicking the Inverse X button flips the sign all the X values of the selected trace. 
With the Smith chart view selected, this shows the conjugate of the trace about 
the Real axis. The new trace displayed is now the range of impedance values 
that the matching network is capable of matching. 

 

• Clicking the Find resonant frequency button displays the resonant frequency of 
the selected trace. If the trace was done using the “1 freq” option, the displayed 
frequency will simply be the frequency the trace was conducted at. If “sweep” 
was selected for the trace, the resonant frequency will be the frequency at which 
the X value is zero. 

 

• Checking the Subtract Impedance box gives the user the option to offset R and 
X values; these changes in measurement can be applied to all data traces. Click 
‘Apply’ or hit Enter to accept any changes made and to save the new R and X 
values to the file. 

 

• Checking the Rotate Gamma box enables the user to enter a value in degrees; 
based on its degree of rotation, the change in Gamma of the data trace being 
edited will be reflected graphically on the Smith chart and in other data displays. 
Click ‘Apply’ or hit Enter to accept any changes made and to save the new 
measurement to the file. 
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Display and Scaling Functions  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 

Colors and Gradient 
 
The user can choose between colored traces on a black or a white background, or a 
white background with black traces and labels.  
 
In the color trace mode, the Gradient feature may be enabled for the Smith chart by 
selecting the Rainbow button in addition to the background option. This adds a time 
dimension to the graph, so that the first point measured on a trace is blue, and the last 
point is pink.  
 

  

Black Background 

Show Table 

Frequency 

Sample 
Number 

Time 

Show 
Line 

Show 
Data 

Points 
Selected 
Only 

Selected 
and 

Dimmed 

Show All 

Selection 
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Fit Screen 

Zoom 

Reset 
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Black and White 

Show 
Labels 

Show 
Reference 

Note: Red Arrows Indicate Smith-Chart-Only Functions 
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Show Table 
 

Inserts a table into the bottom half of the display, with data for R and X values of each 
trace.  
 
 

Sample Number 
 

With the table displayed, selecting “Sample number” will highlight a cursor on the trace 
and provide R and X values in the table for that specific sample point. Adjust the sample 
number being displayed by moving the slider bar.  
 
 

Frequency 
 

With the table displayed, selecting “Frequency” will highlight a cursor on the trace and 
provide R and X values in the table for that specific frequency. Adjust the slider bar to 
move the cursor and change the frequency being highlighted. Note that this is only 
applicable to runs that were a frequency sweep.  
 
 

Time 
 

With the table displayed, selecting “Time” will highlight a cursor on the trace and provide 
the R and X values for a specific point in time. Adjust the slider bar to move the cursor 
and change the time.  
 
 

Show Line 
 

Toggles the line for the displayed trace(s) on or off 
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Show Data Points 
 

Toggles the individual data points for the displayed trace(s) on or off.  
 
 

Selected Only 
 

Only the selected trace will be visible on the display.  
 
 

Selected and Dimmed  
 

The selected trace(s) will be displayed in the primary color. All other traces listed in the 
Traces window of the Control Panel will be displayed in grey (default).  
 
 

Show All 
 

Every trace listed in the Traces window of the Control Panel will be displayed in color.  
 
 

Selection  
 

Allows the user to zoom in on a specific region of the graph by dragging a box around 
the desired area.  
 
 

Scrolling 
 

Allows the user to drag graph in any direction by clicking and holding, then moving the 
mouse.   
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Horizontal Zoom 
 

For all formats other than Data and Smith chart, the user can zoom in or out along the 
horizontal axis.  
 
 

Horizontal Fit Screen 
 

For all formats other than Data and Smith chart, the chart will center horizontally on the 
data trace.  
 
 

Vertical Zoom 
 

For all formats other than Data and Smith chart, the user can zoom in or out along the 
vertical axis.  
 
 

Vertical Fit Screen 
 

For all formats other than Data and Smith chart, the chart will center vertically on the 
data trace.  
 
 

Fit Screen 
 

For Smith chart only, adjust screen to center on the selected trace.  
 
 

Zoom 
 

For Smith chart only, allows the user to zoom in and out.   
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Reset 
 
Centers the screen on the entire Smith chart.  
 
 

Switch Grid Type 
 
Cycles through available impedance chart formats.  
 
 

Undo Scale 
 
Undoes the previous zoom or fit command.  
 
 

Add and Show Labels 
 
Toggles any labels that have been added to the Smith chart on or off. Toggling the 
‘Show Labels’ function can be done from both the main display window and the ‘Screen’ 
tab in the Control Panel.  
 
To add a label to any point on the Smith chart, right-click on the graph and select “Add 
Label.” Additionally, labels can be edited from their location on the Smith chart by right-
clicking them and selecting the desired option (i.e., Edit, Remove, Add, Hide, or Delete 
all labels). 
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Importing Data from Z’Ware 
 
For users who have access to Advanced Energy’s Z’Scan technology, data can be 
taken from Z’Ware and imported into Z’Analyze. This allows users to create an 
impedance map for devices connected to a Z’Scan sensor. This section will provide an 
overview of how to import Z’Ware data into Z’Analyze.  
 

1. Open Z’Analyze software.  
 

2. Navigate to Select File → Open. 
 

3. From the File Type drop down menu, select Z’Ware files (*.zsd). 
 

4. Choose the location that contains the saved Z’Ware file.  
 

5. Select the desired file and click “Open”. The following window will appear.  
 
 
 
 
 
 
 
 
 
 
 

 
6. Enter the desired start and end time. You can get this most easily by reviewing 

the data set in Z’Ware and then determining the best time from that, based on 
what you are trying to learn from the data.  
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7. For example, if we wanted to determine the steady-state impedance, we might 
want to select 10 to 40 seconds as the Start and End times. If we wanted to look 
at the match trajectory, we might select 0 to 5 seconds.  

 
Select the desired frequency, and then click “OK”. Z’Analyze will import the 
resistance and reactance (R & X) data from the selected time for each trace from 
the Z’Ware file. 

 
8. Select the Smith chart view to see a plot of the chamber’s impedance value over 

the course of the time you entered. 
 

  
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
  

Z’Scan data in viewer 
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Measuring Matching Network Impedance 
Range 
 

For this exercise, we use a 13.56 MHz match, but almost any RF match can be 
measured with the appropriate controller and test fixture.  
 

1. Ensure Network Analyzer is connected to computer (reference hardware 
installation guide). 

 

2. Connect matching network to a control device. 
 

3. Terminate match input with a 50 ohm load. 
 

4. Connect an appropriate test fixture to the matching network output. In the 
absence of a proper test fixture, use the clip connectors and use the correction 
procedure. 

 

5. Connect test cable from Network Analyzer input to matching network output. 
 

6. Open Z’Analyze software on computer. 
 

7. Select File → New to create a new file. 
 

8. Ensure desired settings are selected under Run tab of the Control Panel  
(Recommended: “1 freq”, Samples: 10000, Average: 1, f(MHz): 13.56). 

 

9. Click Run (Blue Arrow). 
 

10. Scroll capacitor from minimum to maximum values. 
 

11. Scroll inductor from minimum to maximum values. 
 

12. Scroll capacitor from maximum back to minimum value. 
 

13. Scroll inductor from maximum back to minimum value. 
 

14. Click Stop.  

Test Cable 

Matching Network’s input 
terminal, with 50 Ohm load 

waiting to be attached. 
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Document Information 
 
 
 

© 2023 Frontier Technical Services. All rights reserved. 
 

Frontier Technical Services 
2100 W Drake Rd, Suite #4 
Fort Collins, CO 80526 USA 

Tel: +1 970 217 6535 
 

https://www.ftsplasma.com/ 
 
 
 
Disclaimer  
The information contained within this manual is currently in the process of review, and is therefore continually being improved upon. As 
such, materials herein are subject to change by the writing staff of Frontier Technical Services without first notifying the reader. 
 
Copyright  
The information contained within this user manual is the intellectual property of Frontier Technical Services. None of the following 
information may be re-published without first obtaining permission from Frontier Technical Services. Unauthorized use of this manual 
and/or its contents is illegal. 
 
Statement of Liability  
Frontier Technical Services will not be held responsible for losses of any kind occurring as a result of use of this manual. Likewise, the 
writing staff of Frontier Technical Services will not be liable for any erroneous statements made with regard to the functionality of 
Z’Analyze. 
 
Document Lifetime 
Frontier Technical Services may occasionally update online documentation. If this document was not downloaded recently, it may not 
contain the most up-to-date information. Please refer to https://www.ftsplasma.com/ for the most current version.  
  

https://www.ftsplasma.com/
https://www.ftsplasma.com/


Frontier Technical Services  Z’Analyze® 1.10 Software Manual 

 
 
 

38 

Levels of Access 
Optionally, the user can upgrade their license and purchase an additional level of access for this software through Frontier Technical 
Services, i.e., Level 2, which unlocks the Reference and Replay functions while also granting the user the ability to open Bird© data 
files within Z’Analyze. Please contact Technical Support at crtech@ftsplasma.com for more details. 
 
Trademarks and Property Rights 
Z’Analyze® is a trademark of Frontier Technical Services Corp. 
Z’Scan® and Z’Ware® are registered to Advanced Energy Industries 
Z’Analyze® Software User Manual and the contents therein are property of Frontier Technical Services and may not be used or copied 
without permission. 
Trewmac TE Series RF Vector Analysers are produced by Trewmac Systems Pty Ltd 
Microsoft® is a registered trademark of Microsoft Corporation. 
Windows® is a registered trademark of the Microsoft Corporation 
 
Customer Feedback 
With the user in mind, the writing staff of Frontier Technical Services has carefully written this manual to ensure its ease of use. Despite 
this however, there may still be areas of this manual that may be improved upon. In order to better identify these possible areas of 
improvement, customer feedback is highly encouraged, as it will help provide Frontier Technical Services with the opportunity to 
remedy any unknown problems within Z’Analyze® Software or its corresponding manual. 
 
To purchase Z’Analyze®, report a problem with Z’Analyze®, or notify Frontier Technical Services of any improvements that can be 
made to the accompanying manual, please contact Technical Support at crtech@ftsplasma.com. 
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